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Genie —,;‘l’){ provides the right solution for all your control needs!

Providing excellent performance and functionality, Genie-NX performs simple logic, timing, counting, and real time clock operations. It is an
ideal programmable controller for simple control applications such as building construction equipments, HVAC, parking lot lighting and
other applications in which cost is a primary design issue. All programming and data adjustments can be done via the on-board keypad and
display or with the help ofa software.

Programming Genie-NX with the help of G-Soft NX configuration software is quite simple, without particular programming knowledge. It
facilitates program generation, project simulation and documentation which are accomplished simply using the pick and place functionality,
allowing maximum ease of operation.

Some of its features are:

+ Integrated, ready to use, wide range of programmable functions including 16 timers, 16 (retentive
selectable) counters, 16 time switches, 16 compare counters, 16 soft text messages, 32
auxiliary relays and 12 analog comparators,

» 8digital inputs & 4 relay outputs . Two analog inputs (0 -10V) in 12 -24VDC, model which can be
used asdigital inputs.

» Ability to add up to three(3) extension modules expanding 1/0%s to 32 digital inputs, 16 relay outputs.

» Communication module allows programmable relay to be connected to a Modbus network through
RS 485 link

« Backlit LCD screen for display and modification of pre-selected parameters of function blocks,
viewing I/0 status and programming on the device .

 Ladder programming using software on PC as well on the device with the help of keypad & LCD Display ase Module

« Memory back up allowing programs to be transferred or copied into another Genie NX with the
help ofa memory card.

* Compact size —only 72mm(2-53/64") wide x 90mm(3-35/64") high x 65 mm {2-9/16) deep, reducing
panel area requirements for lower installed costs.

+ Softkeys for convenient creation and editing of programs on the device.
= Available inboth: AC(110- 240 VAC) & DC(12 - 24 VDC)models.

Password & Parameter lock facility.

Approvals (€ :@u u

EXTENSION MODULE

« Extension Module can be used with base module to increase 1/0 capacity of Genie-NX,
*  Every extension module has 8 digital inputs & 4 digital outputs.

+ Connections are made in Daisy chain fashion.

»  Genie-NX can be expanded by connecting 3 extension modules, to obtain a maximum configuration of
32 inputs and 16 outputs.

COMMUNICATION MODULE (.4X Comm )
. ,;"D(l- Comm (RS 485) provides Modbus communication for Genie NX.

* Possible toconnect multiple Genie's witha SCADA system ora HMI over RS 485,
«  Available inboth AC(110-240VAC) & DC(12-24 VDC) models.

ACCESSORIES
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FRONT VIEW OF KEYPAD & FUNCTIONS OF KEYS

The 8 keys located on the front facia of Genie-NX are used to configure, program and control the application.
They perform the following actions:

DEI

This key is used to delete a program element or a blank line, if the cursor is located at the extreme column.

ALT

This key is used for selecting/exiting a parameter in the edit mode and to show either the Parameters or Program
while the program is running. This feature is also useful for debugging,

DK

This key to is used to insert a program line, when cursor is blinking in the first column of first row. During the

parameter entry while editing this key saves the changes and proceeds to next parameter. In RUN maode, this key
can be used to select one of the 3 displays. This also selects/deselects links.

ESC

This key 1s used to exit the menu or a selection. During the parameter entry it proceeds to the next parameter without saving the changes.
ARROW

On the program editor screen, the arrow keys are used to move up, left, down and right. The position on screen is shown by a cursor or

blinking text

AUXILIARY or Z-Keys

Arrow keys are called auxiliary keys in Run mode. They are used as push buttons to get signals from user. [f user goes in PAR (parameter
maode) . then these keys are not available as z-keys. At that time these keys are used as arrow keys
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SUPPLY. INPUT & OUTPUT CONNECTIONS
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Connection Between Base Module & Extension Module
Same for bath AC & DC

Power Supply Wiring
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Connection Between Base Module & Communication Module

1. Although the Genie has been designed to withstand the negative effects of any electrical noise that might be present in the incoming power supply it may be necessary
to insert an isolation transformer between the supply and the line terminals of the Genie.
2. While using the DC Genie-NX. run the 24 VDC Input line away from the 100 V AC and 200 V AC lines.

Wiring of Input/Cuput
1. Separate the Input lines and output.

2. When the output lines are running close to power supply lines or the Input lines use batch shielded and ground them.
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PROGRAM

Sereen T

Sereen 8

Sereen 9

X at the Device: Menu eI Functions

Programming and other settings in Genie NX can be done using the software
aswell as on the device itself'with the help of the backlit display and keypad.
When the connections are made and the device is powered ON, screen | is
displayed on the device. By default the cursor will blink on the ‘PROGRAM”
option. Using the Up, Down keys, user can select between any of the options.
‘When the cursor is on the PROGRAM option and OK key is pressed, then
sereen 2 is displayed,

When screen 2 is being displayed, the cursor is on the ‘EDIT  option.

Press the OK key to enter this option & screen 6 will be displayed. Similarly
by pressing down key and OK, one can enter the other functions viz,
“DELETE", "TRANSFER", “MODBUS CONF" and screen 7.8 and 9 will be
displayed respectively

EDIT

This function allows the user to enter a new program or edil an existing
program. If Password is set, then this function is accessible only with the
correct password,

DELETE

This function will clear the entire program stored in the Genie-NX. If
password is set, then this function will work only with correct password.
TRANSFER

This function will transfer the program from device to memory card or vice
wversa, Program data on memory can also be deleted in this mode.

MODBUS CONFIG

This function will set Mod bus Slave configuration data.

The user can set the following communication parameters:
*SLAVE D, BAUD RATE, PARITY ,STOPBIT

RUN

When sereen 1 is being displayed, press the down key to shift the cursor to the
RUN option and press OK key to enterit. Screen 3 will be displayed.

RESET

The RESET Mode resets all the previous states of Inputs/Outputs, clears
timer and counter states, starts afresh.

CONTINUE

The CONTINUE Mode does not change the states of the Inputs/Outputs and
special functions and continues with the execution of the program.

PARAMETERS

Sareen 4

When the cursoris on PARAMETERS option and OK is pressed then screen 4
will be displayed.

PARAMETERS

This function displays and allows the user to change parameters of special
functions like timer, counter, Time switch (clock), compare counters and
analog functions used in the program. This may be password protected and
may have additional individual lock for each parameter.

UTILITIES

Sereen § Sereen 10

Sereen |

When the cursor is on the UTILITIES option and OK key is pressed, then
screen 5 is displayed.

When screen 5 is being displayed, the cursor is on the *SET CLOCK option.
Press the OK key to enter this option & screen | will be displayed. Similarly
by pressing down key and OK, one can enter the other functions viz.
“PASSWORD”, “EXTMOD™, "BACKLIT CONF" and screen 7,8 and 9 will
be displayed respectively

SET CLOCK

This function is used to set the day and time: Day of the week, Date, Hours-
Minutes. This function is available only on Genie-NX unit,

PASSWORD

This function allows setting of password. If password is set, certain functions
like Program, Parameters are protected and are accessible only when correct
password is entered. The Password can be set or removed; the status is
indicated by the open or closed lock symbol,

EXTENSION-MODULE

Tltls function allows the selection of the Extension Modules {A/B/C).
3 Extension Modules can be connected to the Gienie-NX Main
Unit. In the G-SOFT NX on PC, extension modules have 1o be chosen using
the "Configuration" menu.

BACKLIT CONF

This function allows the setting nfbm:khght in either On, OfF or Aute mode.
In the Auto mode, the backlight comes up only when a key is pressed on the
device and remains for 10 seconds. 1f the ON or OFF modes are selecied the
backlight will be permanently ON or OFF respectively.
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' Elements / Function Blocks

In ladder programming, the ladder elements / Functional Blocks are connected to create a ladder for any application. The following section gives the description of

each element that is used for ladder programming.

INPUTS

Genie-NX provides 2 types of Inputs viz. Digital & Analog
AC Model: Digital Inputs (1 - 8}

DC Model: Digital Inputs (1 - 6), Analog Inputs (V1, V2)

OUTPUTS

Genie-Nx provides Digital Outputs: Base Module (4), Extension Module (4)
The outputs can be configured as:

I. State Change (Contactor), ii. Level Change (Remote Contral), iii. Bi-stable
{Set Reset)

I1,12,...18 Base Module Q1,02, ... Q4 Base Module
i Nonéla"y Open [ Extension Module 1 UL U2, ... U4 Nongﬂlly Open | Extension Module 1
K1K2, .. KB_| (0 Contacty | EXension Module 2 VL V2 V4| 6 Contact) | EXtension Module 2
Ll L2 B8 Extension Module 3 Wi, W2, ... W4 Extension Module 3

il,02, w18 Base Module ql,q2, .....q4 Base Module
il, j2, 8 Nonn&:ly Closed Extension Module 1 ul, u2, ..... ud Nomglly Closed Extension Module 1

5 tact 2
kl, k2, (NC’ gt::lttm] Extension Module 2 vl, v2, ...ovd (‘NCPE:':ﬂact) Extension Module 2
11,12, Extension Module 3 wl, w2, ... wd Extension Module 3
TIMERS TIME SWITCHES

Genie-NX provides 16 Timers which can be configured as:
1. ON Delay, ii. OFF Delay. iii. Single Pulse iv. Symmetric/Asymmetric

T1,T2, ... Tl6 | Timer Coil / Normally Open (NO) Contact

o B A Normally Closed (NC) Contact
Trigger Input
Timer Number
Timer Mode Make/Break Status of *NO* Contag
Reset Input LockedUnlocked State
Preset Time Unit Preset Time Period

Current Time Unit Current Time Period

Genie-NX provides 16 Time Switches which can be used for daily or weekly
applications

61,01, ...016
ole2, ..6l6

Normally Open (NO) Contact
MNormally Closed (NC) Contact

From To

Time Switch Mo
= g Make/Break S
Start Thme ake/Bred tatus
End Time of "NO* Contact
Locked/Unlocked State

ANALOG COMPARATORS

Genie-NX provides 12 Analog Comparators which can be used for
comparison between values of two analog signals or between a an analog
signal and any absolute value

Al A2, ... Al6
al,a2,...al6

Mormally Open (NO) Contact
Normally Closed (NC) Contact

Compare Input
Compare Function
Absolute Value

Analog Comparator No
LockedUnlocked State

Make/Break Status of “NO' Contact

COMPARE COUNTERS
Genie-NX provides 16 Compare Counters which can be used for
comparison between values of two counters or between a counter and any
absolute value
L. Up Counter, ii. Down Counter

Pl P2, P16
pl. p2, ... pl6

Normally Open (NO) Contact
Normally Closed (NC) Contact

Compare Input
Compare Function Compare Counter No
Absolute Value LockedUnlocked State

Make/Break Status of “NO" Contact

COUNTERS
Genie-NX provides 16 Counters which can be configured as:
L. Up Counter, ii. Down Counter

Cl, C2. ..... C16 |Counter Coil / Normally Open (NO) Contact
Gl aLh MNormally Closed (NC) Contact

Preset Value

Direction Input Current Value

AUXILIARY RELAYS

Genie-Nx provides 32 Auxiliary relays which can be used to expand a rung
from one line to another line.

It can be configured as:

1. State Change (Contactor), ii. Level Change (Remote Control). iii. Bi-stable
(Set Reset)

M1, M2, ...M16| Auxiliary Coil / Normally Open (NO) Comaclf
Normally Closed (NC) Contact |

ml, m2, ....mb

Counter Unit
Reset Unit

Retentive Selection (Y/N)
Locked Unlocked State
Make/Break Status

of “NO" Contact

Counter Number

SOET TEXT MESSAGES ;
Genie-NX provides 16 Soft Text Message blocks which can be used to

display text messages, the Preset Value and Current Value of any Special
Function Block or the Current Date and time

[x1, X2, ..... X16|Used for viewing Alarms, HMI Funetionality |

Z-KEYS

Z-Keys are navigation keys provided on device fromt facia. They behave
exaetly like the physical inputs {Diserete inputs). The only difference is

that they do net correspond to smart relay connection terminals, but to the

four gray buttons on the front panel.

Z1, 2 e B Normally Open (NO) Contaet
zl; 22, 216 Normally Closed (NC) Contact

-Z-Keys can be used as navigation keys for current displayed menu.
To use Z-Keys go to RUN Screen or RUN LADDER Screen and Press
ALT which will display the Z-Key Screen. Then Press Z1 - Z4.
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Setting the Clock

1. Select the “UTILITIES” option from the Main Menu and press OK.

2. Selectthe “SET CLOCK” option from the Sub Menu and press OK.

3. The cursor will blink on the first digit of the date, press ALT to edit the digit

4. The digit will now start blinking

5. Using Up{Z4) and Down(Z2) keys sclect the appropriate digit.

6. Now press Z.3 to edit the other digit and using Up & Down keys select the digit.
7. Now press OK to confirm the changes that have been made.

8. Repeat the same procedure to set the month, year. hour and minutes.

Once all the parameters have been set, pres OK to save the changes and exit.

!

PASSWORD

The password secures access to the following main menu options:
"PROGRAM","PARAMETERS" and "UTILITIES"

Inrun mode password protects the run time parameters and ladder viewing.

The password comprises four numerie digits from 0 to 9. Therefore the password
can have any value between 0 and 9999,

Extension Module Selection

1. Select the “UTILITIES” option from the Main Menu and press OK.

2. Select the “EXT MOD™ option from the Sub Menu and press OK.

3. The cursor will be blinking on *A’, press ALT to edit and the * A’ will start blinking.
4. Press Up{ Z4)or Down(£2) keys to select or deselect the extension module,

5. Adark square around ‘A’ indicates that the module has been selected.

6. Now press OK to confirm the changes that have been made.

7. Repeat the same procedure if the other modules are to be selected.

8. Press OK to save the changes and the *UTILITIES” submenu is displayed

oK oK ALT 74

If only one extension module is being used and it has been assigned as “A’ on the
extension module using the selection switch then make sure that * A’ is selected in the
'EXT MOD option in the *UTILITIES” menu. [f more than one extension modules
are being used then make sure that the modules have been assigned and selected
appropriately because this in turn will affect the inputs and the outputs.

Setting the Password

1, Select the “UTILITIES" option from the Main Menu and press OK.

2. Select the “PASSWORD™ option from the Sub Menu and press OK.

3. The unlock symbol means that the password is not yet set.

3. The cursor will blink on the first digit of the date, press ALT to edit the digit

4, The digit will now start blinking

5. Using Up(Z4) and Down(Z2) keys select the appropriate digit.

6. Now press Z3 to edit the other digit and using Up & Down keys select the digit.
7. Repeat the same procedure o setall the 4 digits.

8. Wow press OK to confirm the changes that have been made.

9. Againon pressing OK the password is enabled and the Main Menu is displayed

oK ALT 24

Backlit Configuration

1. Select the “UTILITIES” option from the Main Menu and press OK.

2. Select the *"BACKLIT CONF” aption from the Sub Menu and press OK.
3. The *Auto’ option will be displayed with the cursor blinking on it.

4. Press ALT to editand the Auto option will start blinking,

5. Press Up(Z4) or Down(Z2) keys to select other options viz. ON, OFF.

6. Now press OK to confirm the changes that have been made.

7. Press OK tosave the changes and the “UTILITIES submenu is displayed.

0K 0K ALT 74

}‘ O oK

ALTO: In AUTO mode, whenever a key is pressed the backlit will be switched
ON and will switched OFF after 10 seconds.

ON: In ON mode, the backlit will be permanently switched ON.

OFF: In OFF mode, the backlit will be permanently switched ON.

Removing the Password

1. Select the “UTILITIES™ option from the Main Menu and press OK.

2. Select the “PASSWORD"” option from the Sub Menu and press OK.

3. The lock symbol means that the password is set.

3. The cursor will be blink on the first digit, press ALT to edit the digit

4, The digit will now stari blinking

5. Using Up(Z4) and Down(Z2) keys select the appropriate digit.

6, Now press 23 to edit the other digitand using Up & Down keys select the digit,
7. Repeat the same procedure to set all the 4 digits.

8. Now press OK to confirm the changes that have been made.,

9. Againon pressing OK the password is disabled and the Main Menu is displayed

Ladder Program Protection

1. If the password is already enabled and user attempls to gain access using
wrong password, then an error message is displayed.

2. If four such consecutive attempts are made then user is presented with options
to either delete the entire device dala or else revert,

3. Ifthe DELETE ALL option is selected , then all device data including
Password and Ladder is erased. The user can then re program the Ladder using
G-SOFT NX and secure it with a new password.

“

After four wrong attempts of entering the Password this Screen as shown below
appears. Pressing OK here, will delete all device data.

i D oK
B R

After four wrong attempts of entering the Passward it user presses ESC the device
will return to last menu mode from where it has entercd in PASSWORD screen.
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Creating or Editing a Ladder

To ereate a new ladder or edit an existing ladder, select the PROGRAM option from
the Main Menu by pressing OK.

Select the EDIT option to create or edit a ladder.

Inserting a Contact

1. Place the blinking cursor in the required position,

2.Press ALT.

3. Choose the required element using the Up or Down keys.

4. Use the Right Arrow key to move to the number,

5. Choose the number using up or down keys.

6. Press ALT or Right Arrow to aceept and to go to next position.

m24

O

Inserting a Coil

L. Place the blinki in the required position.

2. PressALT.

3. Choose the required element using the Up or Down keys.

4. Use the Right Armow key to call-up the number.

5. Choose the number using Up or Down keys.

6. Use the Left Arrow key to move to the type of coil .

7. Choose the type of coil using Up or Down keys.

8. Press ALT or Right Arrow to accept and to go fo next position.

ALT 23 ALT

TRANSFER

The TRANSFER function allows data to be transferred from Memory Card to
Genie NX or vice-versa.

Transferring data to memory card is useful when user wants to load the same
program in many Genie-NX units. In this case instead of using PC user can make
use of memory card, which is capable of storing one program. This feature is
particularly useful on the production line where user is not required to edit and
debug the program and a PC is notavailable.

In this mode of transfer "PASSWORD"and "UTILITIES"such as Backlight
configuration & Extension module state will also get transferred with the program
ladder.

Devie to Card

1. Insert the Memory card in the connector after removing the serial cable, if
present.

2. Selectthe "TRANSFER" function from the "PROGRAM" menu.

3. Press the OK key to validate.

4. Select the Device > Card function,

5. Press the OK key to validate.

Card to Device

This transfer is used to reload an application into the Genie-NX. It avoids the need
tore-enter an existing application.

1. Insert the Memory card in the connector after removing the serial cable, if
present.

2. Move cursor to the "TRANSFER" function from the "PROOGRAM" menu.

3. Press the OK key to validate.

4. Select the Card > Device function.

5. Press the OK key to validate.

Entering a Link

1. Place the blinking cursor next to the desired location.

2. Press OK to start the link (" s ", "cursor")

3. Move the cursor to the desired location using the arrow keys.

4. Asthe cursor moves, the link is drawn.

5, Press OK to exit to normal mode.

6. Repeat this action as many times as necessary to link all the elements together as
required

OK 22 OK

Deleting a Program Line

Move the cursor to the first column of the ling, if necessary delete the elements one
by one to create a blank line. Press Del. The line is deleted.

It is also possible to delete the entire program stored in the Genie-NX., To do this,
call up the "DELETE" option in the Program menu and validate the deletion of all
program lines.

Replacing a Link with a Contact

To replace a link with a contact, simply place cursor at the required location and
press ALT to enter the contact

Changing an Element
To change an element in an existing program, simply move to the element to
change, press ALT and follow the same procedure as when entering a new element

Peleting an Element
To delete an element, simply place the cursor on the required element, then press
Del. Generally, the deleted element must be replaced by a link

Beleting Links between Elements

To delete a link, simply move the cursor next to the desired position, press
key to change the cursor to & and press Del. Key. This may delete some
required connections, which may be restored by the same method as aboy
Inserting a Program Line ._/{

To insert a program line, simply move cursor to the first column of the line
immediately above the one to ereate and press OK.

Editing Parameters of Special Function Blocks
Parameters of special Function Blocks can be modified in two modes
I. Run Mode 2. Program Stop Mode

Run Mode

1. Enter the PASSWORD if it has been enabled.

2. Special function block with it's parameters set will get display.

3. Set parameters & press OK to save the parameters.

4. Press ESC to return Run Mode Menu .

5. Ifuser do not press OK and do press ESC previous settings retains & returns to
Run Mode Menu

OK

ESC
P

Program Stop Mode

Enter the PASSWORD if it has been enabled and press OK to save the parameters
If user do press ESC key without pressing OK the screen as shown will appear,so
that user can have three options as:

EDIT: Again enter into parameter set mode.

SAVE AND EXIT: Save the parameters & come out of mode.

EXIT: Retain previous settings & come out of set mode.
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RUN MODE MODBUS SETTINGS
To enter into RUN mode select the "Run" option in the main menu and press "OK'. Slave ID
1. Select the “PROGRAM” option from the Main Menu and press OK.
OK. OK 2. Select the "MODBUS CONF™ option from the Sub Menu and press OK.

3. The cursor will blink on the first digit ofthe Salve ID (SLV ID).

4. Press ALT o edit the digit and the digit will now start blinking

m— . . 5. Using Up{Z4) and Down{Z2) keys select the appropriate digit.

Ifthe CONTINUE option is selected then Ladder Program execution will proceed | 6 Now press Z3 to edit the other digitand using Up & Down keys select the digit.

& the Run mode display screen will appear as shown 7. Now press OK to confirm the changes that have been made.
If the RESET option is selected then all special function block parameters are

initialized & the Run mode display screen will appear

OK 0K ALT 74
Run Mode Functions
During the Run mode  the user can enter the Run Mode Functions by pressing the
ESCkey
L Z3 Z4 0K

Baud Rate

8. Now press Z3 to select Baud Rate (BAUD) and press ALT to edit..

9. Using Up(Z4)and Down(Z2) keys select the appropriate Baud Rate.
10. Now press OK to confirm the changes that have been made.

F] 24

Parity

11. Now press Z3 to select ‘PARITY "and press ALT to edit..

12. Using Up{Z4) and Down(#2) keys select the appropriate parity.
13. Now press OK to confirm the changes that have been made.

=y

Z3 Za

PAUSE
Ifthe PAUSE option is selected by pressing OK then program execution is paused.
And user can have two options as

Continug: Runwith the parameters status it has or ST
Reict: Russtihe parameters and run the prograrm. 14, Now press 23 to select “STOPBIT and press ALT io edit..

15. Using Up{Z4) and Down(Z2) keys select the number of stop bits.
STOP 16, Now press OK to confirm the changes that have been made,
If the STOP option is selected by then the program execution is stopped & Main
Menu is displayed on the screen. 73 74 oK
PAR RUN

Afthe PAR RUN option is selected then Parameter edit window of Special Function

gﬁ‘;‘k is r}.isplayed. The user can edit the parameters by using ALT, UP, DOWN & | 17, Once all the changes have been made press OK to save and exit.
EYS.

PROG RUN

If the PROG RUN option is selected then the ladder program is displayed on the

sereen. The user cannot edit the program and can only go through the program by

using UP, Down keys

If Z-Keys are used in the program then pressing the ALT key will display the Z-Key

screen. Parameter Lock

When user edits parameter from text message and if parameter is locked then above screen

appears. To change that parameter user has to edit that parameter in edit mode only.

* Ebedied parsmeters when unlocked snd edited at s tlise will not be saved permanesily in the device, This Fnctionality is
praided emly bo best the during rus ime. To save mcly, user has o stop e b il o e
comfigure the system aveondangly.

oot InRun Mode, extansian module idenities cannot be changad
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ing the G Soft-NX Software

Ci-Soft NX is the exclusive programs

ing software for the Genie NX using Windows®, It facilitates;

Entering the Program: Select & Place

G-SOFT NX provides a user-friendly interlace wherein the user has 1o only select contact type and contact
number and place it where it is required. Contacts get connected automatically if they are on the same line.
User can enter comments for better readability and for future reference .

Saving Programs

G-S0FT NX allows user to save individual programs on the PC.

Debugging
G-50FT NX is very powerful in error handling. It displays any possible errors as the program is being
entered to make corrections simultaneously.

Simulation on PC

User can simulate the program on PC. User can use buttons provided on the screen to simulate the input
connections. Scroll bar can be used to simulate Analog input. The actuation/ de-actuation of the relays can
be monitored on the screen.

Simulation on Genie NX

User can connect Genie-NX unit to PC using a serial Communication cable / USB cable and perform on line program simulation. In this mode the PC acts as a master and the
inputs are taken from Genie-NX and outputs are sent to Genie-NX unit (and the extension modules, if connected). This mode is useful in debugging the entire system since the
actual F'Os are used,

Printing

User can take print outs of programs in two different formats, namely Short format and Detail format, Also, program Parameters and Comments can be printed,

ns

Programs can be transferred from PC to Genie-NX and vice versa using serial Communication cable / USH cable. This saves the program entering time on Genie-NX.

Iransfering Pr

Transfering Clock

With this utility user can set the clock (date and time ) on Genie-NX.
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Input/Output

Window
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Program Errors

Diescriphon

Error Window

Select File ->New from the menu bar to create a new program.

A blank screen will appear. Now you can start entering the program. Ensure that you have chosen proper Genie-NX Configuration before starting the program entry.

Choosing Contact Type

Position the cursor at the place where you want to insert the contact by a left click with mouse. The position will get highlighted. Choose the required contact type and Contact
Number from /O function selector, Click on the required contact and contact number. which will be highlighted for a few seconds. The selected contact will appear at the
position selected in the program. The selected contact number will be shown with a tick mark to indicate that it has been used in the program, You can right ¢lick on any of the
contact to change its type and properties.

Connecting Inputs & Outputs

Each circuit connection runs from left to right. Please remember this when you interconnect contacts and relay coils. User can draw a circuitconneetion horizontally from left
to right and vertically between adjacent circuit connections. An intersection of circuil connections represents an electrical connection.

Horzontal connection

To make a horizontal connection, click on the horizontal dotted line in the connection box of the circuit. Or to make connection in contact box, press right button and sclect
"Joining link". Generally when an output coil is placed in the fourth column, it gets automatically connected.

Vertical connection

To'make a vertical connection ¢lick on the vertical dotted line in the connection box of the circuit. Vertical connection represents OR connection, For deleting a conneetion
just left¢lick on the connection line.
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I'o Set & Remove Password

+  Select the Configuration >Device Utilities menu command. Then Device Utilities window
will pop up as shown in the adjoining window.

+  Click on set password,

+  Enter four digits password in the two boxes “New password” and “Confirm New™
Password then confirm with OK.

+  You can delete your assigned password at any time. To do this, enter the existing password
in *Old password” box. Then confirm with OK.

+  To change the password, you must first enter the new password in the two boxes “New
password” and “Confirm Password ** and the existing password in Current password text
box. Then confirm with OK.

o Set Backlit Mode

+ Select the Configuration >Device Utilities menu command. Then Device Utilities window
will pop up as shown in the Com Port Settings window.

+  Select the mode Auto, On or Off then click on the set mode button.

*  Then “The requested operation will move the device out from the run mode. Do you want
to continue?™ message will pop up.

+ Ifpressed Yes, then backlight mode will get set in device and "Backlight mode has been set
successfully" message will appear on the screen.

o Configure Communication Port

*  Select the Options > Comm port menu command. Then COM Port setting window will pop
up as shown in the adjoining window showing two option buttons to select the Port.

+  Select “Device is connected to USB port” when the device is connected with cable.

»  Select “Device is connected to Serial Communication port™ when the device is connected
with Serial Communication cable,

To Set Communication Parameters
+  Select the Options > Comm port menu command. Then COM Port setting window will pop
up as shown,

+  The user can set the following communication parameters:
SLAVE ID: Selectable from 1 to 247.
BAUD RATE: Selectable as 1200,2400,4800,9600 baud.
PARITY: Selectable as NONE, EVEN and ODD,
STOP BIT: Selectable as 1 and 2 stop bits.

Clock Setting

+  Select the Transfer > Device Clock menu command. Then Device Clock window will pop
up as shown in the Device Clock window.

* To view Date and time of device: Click Read button on the clock setting window. Then the
Clock Setting window will show the Date and Time of the device.

+  To set Date and time in the device: User can select Date and Time to write into the device,
Click Write button on the clock setting window.

DST (Daylight Saving Time) Setting

*  Select the Transfer = Device Clock menu command. Then Device Clock window will pop
up as shown in the adjoining window.

+  To set Enable DST, Follow the following steps: Click Daylight Saving Time check box then
the DST setting section becomes visible,

= User can select the following parameters: Begin Week, Begin Day, Begin Month, Begin
Time, End Weck, End Day, End Month, End Time, Offset Time

*  To set Disable DST, Follow the following steps:
1. Deselect Daylight Saving Time option then DST window will get disable.
2. Press Set DST.

+ Toread DST: Press Read DST, independent of the DST enable or disable.

Iransfer Options

PC to Device

+  Select the Transfer = Program menu command. Then transfer window will pop up as shown
in the Transfer Window

*  Press "PC to Device" button on transfer dialog box. Current program on the screen will get
iransferred (o device,

+  Transfer completion message "The Program is downloaded successfully” will appear on the
screen.

Device to PC

+  Select the Transfer > Program menu command. Then transfer window will pop up as shown
in the adjoining window

»  Press "Device to PC" button on transfer dialog box. Current program
on the screen will get transferred to device.

»  Transfer completion message "The Program is downloaded
successfully” will appear on the screen.
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+  Read program will be shown on main screen. Supply |Di|-1d Inpute |ﬂnuln=3‘miandj Inputs: |P.'ng Lines
GIOTY 110240 V AC (B2 110-240 ' AC Taone =
Extension Module Selection ID0TS B: 1224 VDG 3010V D¢ 250
= Select the Configuration =PLC Model menu command. Then Model 4 | v
Selection window will pop up as shown.
= Selection of Genie-NX model and Extension modules, Maximum Eutemsicrmodidas
three extension modules can be connected to one Genie-MNX. ra 8 rc P | agcel
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FACTORY/SCHOOL SCHEDULE
Opening bell at Bam announces start of work or ¢lass (bell to last 10 sec and stop): Bell at 10:30am announces start of coffee break, Bell at 10:45am announces end of coffee
break, Bell at 1 Znoon announces lunch, Bell at 12:45 announces end of lunch, Bell at 5pm announces end of work day

Programming

For the 6 time periods 6 Time Switches are required. ©1,02, ... 86 represent the 6 Time Switches,
Timer T1 ensures that the duration of the output is 10 seconds only.

(1 represents the Output Coil (Alarm/Bell in this case)

Double click on the G SOFT NX icon the launch the G SOFT Software application,

Click on File New to launch a new Program window.,
Time Switch Selection & Parameter Editing

1. Click on the Time Switch symbol inthe 1/O selector window and select Time Switch 1 (& 1)

2. Move the cursorto the “*Contact ' column ofthe first row and left click on the block to place the Time Switch.
3 Right click on the Time Switch and select properties to open the properties window.

4. Inthe Weekday settings option select *From’ as Monday ans ‘To’ as Saturday.

5. Inthe Daily Duration option enter the start time as 10;30 and since we want the siren for 10 sec, enter end time as 10:31,
6. Similarly select the other 5 Time Switches and enter the times as described above and place them in the contact | column of lines 2, 3,4, 5 & 6.

Qb‘.‘ Contact-1 | Ure Insart pAemrey st Dailychration:  HH < MM
.. o i s

¢ [::i | : To: [Satudsy - End fma: 1]

Timer Selection & Parameter Editing

y

7. Select Timer T1 from the /O selector window and place it in the coil column of line 1and contact column of line 7.
8. Open the Timer properties window and select the mode as Interval and enter the time duration i.e. SPas 10 sec.
9. Connect the lines from all the Time Switches to the Timer as shown in screen,

= Mode
Cail End of Clazz SP
* SEC
| & |OnDely
7 > T — b — T 3 50100y >oioo &
T2 i ™ HH:MM
a1 D | Asymmetric
Output Configuration
10. Select Output Q1 from the /O selector window and place it in the coil column
11. Right click on output ()1 to and select the option *State Change: Contactor’
=y ]
piE > qu T State Change: Conkactor
-(& "1 |schoct Bel | Lewel Change: Remate Control
AUX
=xd
LADDER PROGRAM
Contact-1 Connection-1 Contact-2 Connection-2 Cantact-3 Connection-3 Coil
0 ' : : TT1 .
) e 4 . WEE— dono oo
Start of Coffes i i
a3 B3 ... [EE - - [ R e
End of Coffee break] ' H
04 a4 ... - R 4o san < OSSR
Start Lunch Break ¥ |
05 ol U - -~ - -—- - [ el
End of Lunch Break) 5 :
o8 06 o EENSEEE. . SRR, v
End of Class i H i
i H : : I io1
i H i S chonl Bell
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CAR PARKING

There are 5 parking spots available in a parking area. There are 2 sensors, one at the entry gate and one at the exit gate. When all the parking spots are occupied, there isa lamp
outside the entry gate indicating parking is full. When any of the parking spots is available, other lamp is switched ON indicating parking is available.

Programming

Input 11is the sensor at the Entry gate and Input 2 is the sensor at the exit gate.
Output Q1 indicates that Parking is available, Output 2 indicates that Parking is Full.

Counter C1 is used to count the number of vehicles that have entered or exited the parking.
Compare Counters P1 & P2 are used switch ON outputs Q1 & Q2 respectively by comparing the count of counter C1.

Input Selection

1. Click onthe Input symbol in the /O selector window and select I1.
2. Movethe cursor to the Contact | column ofthe first row and left click on the block to place the input.
3. Again click onthe Input symbol in the /O selector window and select ‘127,
4. Movethe cursor tothe Contact | column of the second t row and left click on the block to place the input. Also place it inthe Contact 1 column of the third row.

e

QP Basi
LN |

Counter Selection & Parameter Editing
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5. Select Counter C 1 from the I/0 selector window and place it in the coil column ofline 1. Right click on the counter and select the option counting input.
6. Apainselect the same counter C 1 and place itin the coil column ofline3 . Right click on the counter and select the option direction input.

C-1

Y

-2

C-3

Compare Counter Selection & Parameter Editing

Lt BE

= |

[eu

7 [C1

Dl

Y

C-2

C-3

7. Seleet Compare Counter P1 from the 1O selector window and place it in the contact column of line 4.
8. Right click on the compare counter and select properties.
9. Under the compare selection option, select *F17as 'C1°, "OP"as *<", ‘F2"as "Abs Value’ and reference count as 5.
10. Select Compare Counter P2 from the 1/0 selector window and place it in the contact column of line 3.
11. Right click on the compare counter and select properties.
12. Under the compare selection option, select ‘F1'as *C1°, *OP"as *=", 'F2’ as * Abs Value’ and reference countas 5.

I.)_I [T T
| |1 Compare sehection Reference count
< | _T' > __Fl —> F1 op F2 T
B o1 =l & =] [absvaee =]
= 3|
2 -t
[} -l Compare selection Reference count
S __{ » — P2 » 1 op F2 e
; |—1- =] =] = =] [Absvae =]
Output Configuration
13. Select Output Q1 from the 1/0 selector window and place it in the coil column
14, Right click onoutput Q1 to and select the option * State Change: Contactor”
=t fror—
ofp | [Pakingfvalble | | AL T :
-(& i Level Changs: Remate Control
AUX £o2z —
- | IParking Full
LADDER PROGRAM
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Supply Volage 110 - 240 VAC 12- VDO
Supply Variation -20% 1o +10% -3 1o +10%
Frequency S006d He

Power Consumption SVA 5VA
Analog Inputs N.A. 2
Analog Input Range N.A. 0- 10 VDC
Dhgital Inputs 8 8
Digital Input Range {0 - 40 VAC) OFF, (80 - 264 VAC) ON (0 - 4 VDC) OFF. (8 - 26.4 VDC) ON
Chutputs 4 4
Contact Rating BA [ 240 VAC | 3A @ 30 VDC BA fm 240 VAC | SA @ 30 VDC
Input / Owiput Exiension [Max)y Yes (3} Yes (3}
Power Reserve (For clock only) 150 h 150 h
Timers 16 16
Time Switches {Daily Weekly) 16 16
Counters (UpDown, Retentive selectable) 16 16
Comgpare Counters 16 186

Soft Text Messages 16 {Priority Driven) 16 {Priorty Driven)
Analog Functions N.A, N.A,
Auxiliary Relays a2 32
Lines for Ladder Programming 230 50
)ERING INFORMATION

GTDDTY 110} - 240 VAL, Genie Nx Base Module

GRDDTS 12 - 24 VIDC, Genic Nx Base Module

GTDDTSE 110 - 240 WAC, Genie Nx Extension Module

GRDDTHE 12 - 24 VIDC, Genie Nx Extension Module

GIXDTR4 L1100 - 240 VAC, Genie Nx RS 485 Communication Moduls

GEXDTR4 12 - 24 VDT, Genie Nx RS 485 Communication Module

GFDNNIM Memaory Card

GFDNNIS RS 232 Serial Communication Cable

GFDNNI USH Cable

GNXNNI Gienie Wx Software supplied on CD-ROM compatible with Windows D8, 2000, XP & Vista

APPLICATIONS

HVAC Controls

« Energy management

+ Heating Control

+ Cooling systems

« Ventilation systems

« Adr conditioning systems

Machine Controls

= Motor, pump and valve controls
* Air compressors

+ Exhaust and filtering systems

* Water-treatment plants

* Woodworking machinery

* Etching and purification plants

* Interior and exterior lighting control

* Door/gate control

+ Shutter, sun blind and awning control

+ Irrigation system control

Transport facilities

« Conveyor systems

* Hoisting platforms

* Elevators

+ Silo facilities

* Livestock feed delivery

Operational Monitoring Systen

* Access control

* Vehicle control monitoring
* Alarm systems

+ Level limit monitoring

+ Traffic light control systems

* Baggage handling

Other Applications

« Solar-¢lectric systems

* Marine applications

« Harsh environments

* Display panels and traffic
control signs
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General Industrial Controls Private Limited

T-107, M.LD.C., Bhosari, Pune 411026 (INDIA)
Tel: +91 20 30680003/11/31/39 | Fax: =91 20 27122574

Email: marketing(a@ gicindia.com,sales(@ gicindia.com | www.gicindin.com
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